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Add and Remove Cards and Nodes

This chapter provides procedures for adding and removing dense wavelength division multiplexing 
(DWDM) cards and nodes. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary for general 
troubleshooting information and alarm or error descriptions. 

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G107 Remove Permanently or Remove and Replace DWDM Cards, page 12-2—Complete as 
needed.

2. NTP-G127 Add an AD-xC-xx.x Card to an OADM Node, page 12-5—Complete as needed.

3. NTP-G129 Add a DWDM Node, page 12-9—Complete as needed.

4. NTP-G130 Remove a DWDM Node, page 12-11—Complete as needed.

5. NTP-G146 Add a Rack and/or Shelf to a Multishelf Node, page 12-13—Complete as needed.

6. NTP-G147 Delete a Shelf and/or Rack from a Multishelf Node, page 12-14—Complete as needed.
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NTP-G107 Remove Permanently or Remove and Replace DWDM 
Cards

Caution Removing and replacing cards can be traffic affecting.

Caution Do not use this procedure to replace a TCC2 or TCC2P card. To replace a TCC2/TCC2P card, refer to 
the Cisco ONS 15454 DWDM Troubleshooting Guide.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-27.

Note If you cannot log into Cisco Transport Controller (CTC) and you need to remove a card, remove 
the card as described in Step 6. After you log into CTC, troubleshoot the mismatched equipment 
alarm (MEA) with the Cisco ONS 15454 DWDM Troubleshooting Guide. 

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 9-29 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Step 3 If you are removing and replacing a card, go to Step 5.

Step 4 If you are permanently removing a card, go to Step 11.

Step 5 To remove and replace a card, complete the following tasks, as needed: 

• The circuits traversing through the card that needs to be replaced (for example, an amplifier) need 
to be protection switched. For instance, if the card you want to replace is an active transponder 
(TXP) or muxponder (MXP) in a Y-cable protection group, complete the “DLP-G179 Apply a Force 
Y-Cable or Splitter Protection Switch” task on page 10-39 to force traffic away from the TXP or 
MXP that you will remove. If the card you want to replace is the standby TXP or MXP in a Y-cable 
protection group, complete the “DLP-G182 Apply a Lockout” task on page 10-41 to prevent traffic 
from switching to the TXP or MXP that you will remove. See the Cisco ONS 15454 Procedure Guide 
or the Cisco ONS 15454 SDH Procedure Guide for other types of protection switching (path 
protection, BLSR, optical, and electrical).

Purpose This procedure permanently removes or removes and replaces DWDM 
cards installed in the ONS 15454 shelf and rack.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-46

NTP-G32 Install the Transponder and Muxponder Cards, page 3-51

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• If the card is used as a node timing reference, complete the “NTP-G112 Change the Node Timing 
Reference” procedure on page 13-18 to change the timing reference to a card that will not be 
removed.

• If the card is an OSCM or OSC-CSM with an optical service channel (OSC) or any TXP, MXP with 
generic communications channel (GCC) termination, complete the “NTP-G85 Modify or Delete 
OSC Terminations, DCC/GCC Terminations, and Provisionable Patchcords” procedure on 
page 10-43 to delete the termination and recreate it on a card that will not be removed.

Note If you delete a card in CTC but do not remove it from the shelf, it will reboot and reappear in 
CTC. .

Step 6 Physically remove the card:

a. Disconnect any cables.

b. Open the card latches/ejectors. 

c. Use the latches/ejectors to pull the card forward and away from the shelf.

Step 7 Insert the new card using one of the following procedures as applicable:

• NTP-G30 Install the DWDM Cards, page 3-46

• NTP-G32 Install the Transponder and Muxponder Cards, page 3-51

Step 8 Continue with the “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” procedure on 
page 3-57.

Step 9 Complete the following tasks or procedures, as needed: 

• If you switched a Y-cable protection group in Step 5, complete the “DLP-G180 Clear a Manual or 
Force Y-Cable or Splitter Protection Switch” task on page 10-40.

• If you switched the timing reference in Step 5, complete the “NTP-G112 Change the Node Timing 
Reference” procedure on page 13-18 to change the reference back to the new card.

• If you deleted an OSC or GCC termination in Step 5, complete the “NTP-G38 Provision OSC 
Terminations” procedure on page 3-84 or the “DLP-G76 Provision DCC/GCC Terminations” task 
on page 7-20.

Step 10 Go to Step 13.

Step 11 To permanently remove a card, complete the following tasks:

• Delete the circuits associated with the card being removed. Complete the “DLP-G106 Delete Optical 
Channel Network Connections” task on page 7-12, and the “DLP-G347 Delete Optical Channel 
Client Connections” task on page 7-8 as needed.

• Physically remove the card:

– Disconnect any cables.

– Open the card latches/ejectors.

– Use the latches/ejectors to pull the card forward and away from the shelf.

Step 12 If the card you are removing is an OSCM, OSC-CSM, DWDM Amplifier, or Filter card, complete the 
following tasks; otherwise, go to Step 13.

• Reconfigure the circuits (OCHCC, OCHNC, Trails) as needed. Complete the “DLP-G105 Provision 
Optical Channel Network Connections” task on page 7-10 task on page 7-22, and the “DLP-G346 
Provision Optical Channel Client Connections” task on page 7-4 as needed.
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• Reload ANS provisioning. Complete the “NTP-G143 Import the Cisco MetroPlanner NE Update 
Configuration File” task on page 3-39 task on page 3-42.

• Relaunch ANS. Complete the “NTP-G37 Run Automatic Node Setup” task on page 3-83.

Step 13 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 9-29 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure. 

DLP-G254 Place OPT-BST, OPT-BST-E, OPT-BST-L, and OPT-PRE Ports Out of 
Service

Step 1 On the shelf graphic in CTC, double-click the OPT-BST, OPT-BST-E, OPT-BST-L, or OPT-PRE card 
with the ports that you want to put out of service.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 In the Admin State column for the card’s ports, choose OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI) for each port that does not have an OOS-MA,DSBLD or Locked-enabled,disabled service state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Opt Apli Line > Parameters tabs.

Step 7 In the Admin State column for the card’s ports, choose OOS,DSBLD or Locked,disabled (ETSI) for 
each port that does not have an OOS-MA,DSBLD or Locked,disabled service state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

Purpose This task places OPT-BST, OPT-BST-E, OPT-BST-L, and OPT-PRE 
card ports out of service in preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G318 Place OPT-BST, OPT-BST-E, OPT-BST-L, and OPT-PRE Ports In 
Service

Step 1 On the shelf graphic in CTC, double-click the OPT-BST, OPT-BST-E, OPT-BST-L, or OPT-PRE card 
with the ports that you want to put in service. 

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 In the Admin State column for the card’s ports, choose IS,AINS (ANSI) or 
Unlocked-automaticInService (ETSI) for Port 1 (COM-RX) of the OPT-PRE or Ports 2 (OSC-RX) and 
3 (COM-TX) of the OPT-BST, OPT-BST-E, or OPT-BST-L cards.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Return to your originating procedure (NTP).

NTP-G127 Add an AD-xC-xx.x Card to an OADM Node

Note Do not begin this procedure until the Cisco MetroPlanner site plan has been recalculated with the new 
AD-xC-xx.x card added to the OADM node.

Purpose This task places OPT-BST, OPT-BST-E, OPT-BST-L, and OPT-PRE 
card ports in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-27

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure adds an AD-xC-xx.x card to an optical add/drop 
multiplexing (OADM) node.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

A Cisco MetroPlanner OADM site plan recalculated for the new OADM 
card

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note During this procedure, you will use TL1 commands to delete and recreate optical channel network 
connection (OCHNC) or optical channel client connection (OCHCC) cross-connects. You might need to 
refer to the Cisco ONS SONET TL1 Command Guide or the Cisco ONS 15454 SDH TL1 Command 
Guide.

Caution This procedure will affect the service of unprotected circuits that pass through the OADM node.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-27 at a node in the OADM network.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), display the OADM node where 
you will add the card.

Step 3 Click the Circuits tab. 

Step 4 Make a list of all OCHNCs and/or optical channel client connections (OCHCCs) that are carried on the 
express path for both the east-to-west (E > W) and west-to-east (W > E) directions.

Step 5 For OCHNCs and/or OCHCCs identified in Step 4 that are routed on the active path of a splitter or 
Y-cable protection group, force the traffic to the protect path in the opposite side of the ring using the 
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-39.

Step 6 Click the Circuits tab. 

Step 7 Complete the following steps for all OCHNCs and/or OCHCCs carried on the express path that were 
identified in Step 4: 

a. Choose the OCHNC or OCHCC circuit(s) and click Edit. (To choose multiple circuits, press the 
Shift key while you click the circuits.)

b. In the Edit Circuit dialog box, click the State tab. 

c. In the State field on the right, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the 
drop-down list.

d. Click Apply.

e. Repeat Steps a through d for each OCHNC or OCHCC circuit.

Step 8 From the Tools menu, choose Open TL1 Connection. 

Step 9 In the Select Node dialog box, choose the OADM node where you will add the AD-xC-xx.x card and 
click OK. 

Step 10 In the TL1 dialog box, use the DLT-OCHNC command to delete the OCHNC cross-connects for the 
express path OCHNC listed in Step 4, using the following format: 

DLT-OCHNC:[<TID>]:<SRC>,<DST>:<CTAG>:::[CKTID=<CKTID>],[CMDMDE=<CMDMDE>]; 

where: 

• <SRC> is the access identifier from the Channel section in a 2-way wavelength.

• <DST> is the destination access identifier from the LINEWL section in a 2-way wavelength.

• <CKTID> is the cross-connect ID. The default is Blank or None. CKTD is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null, the CKTID field will not be 
displayed.

• <CMDMDE> is the command execution mode. NORM mode is the default behavior for all 
commands but you can specify FRCD to force the system to override a state in which the command 
would normally be denied. 
12-6
Cisco ONS 15454 DWDM Procedure Guide, R7.2

78-17737-03



Chapter 12 Add and Remove Cards and Nodes
NTP- G127 Add an AD-xC-xx.x Card to an OADM Node
For additional information, including valid command values, refer to the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 11 In the TL1 dialog box, use the DLT-OCHCC command to delete the OCHCC cross-connects for the 
express path OCHCC listed in Step 4, using the following format: 

DLT-OCHCC:[<TID>]:<AID>:<CTAG>[:::CKTID=<CKTID>],[CMDMDE=<CMDMDE>]; 

where: 

• <AID> is the access identifier from the Channel section i 

• <CKTID> is the cross-connect ID. The default is Blank or None. CKTD is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null, the CKTID field will not be 
displayed.

• <CMDMDE> is the command execution mode. NORM mode is the default behavior for all 
commands but you can specify FRCD to force the system to override a state in which the command 
would normally be denied. 

For additional information, including valid command values, refer to the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 12 Click Close to close the TL1 dialog box.

Step 13 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcords tabs. 

Step 14 Highlight the two express connections that carry the deleted circuits passing through the node. (The 
express connections are the only ones connecting an EXP_TX port on the last west-side OADM card, 
W > E, with an EXP_RX port on the first east-side OADM card, W > E.)

Step 15 Click Delete.

Step 16 Remove the physical express cables between the EXP_TX and EXP_RX ports specified in Step 14.

Step 17 Insert the new AD-xC-xx.x card in the slot identified by your Cisco MetroPlanner site plan.

Step 18 Complete the “NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs” procedure on 
page 3-57 for the OADM node, following the new internal connections table generated by 
Cisco MetroPlanner.

Step 19 Complete the “NTP-G152 Create and Verify Internal Patchcords” procedure on page 3-81.

Step 20 Import the recalculated OADM site parameters. See the “NTP-G143 Import the Cisco MetroPlanner NE 
Update Configuration File” task on page 3-39.

Step 21 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs. 

Step 22 Click Launch ANS.

Step 23 From the Tools menu, choose Open TL1 Connection. 

Step 24 In the Select Node dialog box, choose the OADM node and click OK. 

Step 25 the TL1 dialog box, use the DLT-OCHNC command to delete the OCHNC cross-connects for the 
express path OCHNC listed in Step 10, using the following format: 

DLT-OCHNC:[<TID>]:<SRC>,<DST>:<CTAG>:::[CKTID=<CKTID>],[CMDMDE=<CMDMDE>]; 

where: 

• <SRC> is the access identifier from the Channel section in a 2-way wavelength.

• <DST> is the destination access identifier from the LINEWL section in a 2-way wavelength.
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• <CKTID> is the cross-connect ID. The default is Blank or None. CKTD is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null, the CKTID field will not be 
displayed.

• <CMDMDE> is the command execution mode. NORM mode is the default behavior for all 
commands but you can specify FRCD to force the system to override a state in which the command 
would normally be denied. 

For additional information, including valid command values, refer to the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 26 In the TL1 dialog box, use the ENT-OCHCC command to delete the OCHCC cross-connects for the 
express path OCHCC listed in Step 11, using the following format: 

ENT-OCHCC:[<TID>]:<AID>:<CTAG>[:::CKTID=<CKTID>],

where: 

• <AID> is the access identifier from the Channel section.

• <CKTID> is the cross-connect ID. The default is Blank or None. CKTD is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null, the CKTID field will not be 
displayed.

• <CMDMDE> is the command execution mode. NORM mode is the default behavior for all 
commands but you can specify FRCD to force the system to override a state in which the command 
would normally be denied. 

• <PST> is the Primary state, which indicates the current overall service condition of an entity. The 
default is IS (in service). 

• <SST> s the Secondary state, which provides additional information pertaining to PST and PSTQ. 
The default is AINS.

For additional information, including valid command values, refer to the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

Step 27 Click Close to close the TL1 dialog box.

Step 28 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab.

Step 29 Complete the following steps for all OCHNCs and/or OCHCCs set to OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI) in Step 7: 

a. Choose the OCHNC or OCHCC circuit(s) and click Edit. To choose multiple circuits, press the Shift 
key while you click the circuits.

b. In the Edit Circuit dialog box, click the State tab.

c. In the State field on the right, choose IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) 
from the drop-down list.

d. Click Apply, and then click OK.

Step 30 Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on 
page 10-40 for OCHNCs and/or OCHCCs that were switched to the opposite side of the ring as part of 
a splitter or Y-cable protection group to return the traffic to its condition before the card was added.

Stop. You have completed this procedure.
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NTP-G129 Add a DWDM Node

Note Do not begin this procedure until the Cisco MetroPlanner network plan has been updated and 
recalculated with the new DWDM node.

Note This procedures assumes that all turn-up procedures provided in Chapter 3, “Turn Up a Node” have been 
completed at the node that will be added. If they have not been completed, do not continue. Complete 
the turn-up procedures at the new node before you complete this procedure.

Note During this procedure, you will use TL1 commands to delete and recreate OCHNC and OCHCC 
cross-connects. You might need to refer to the Cisco ONS SONET TL1 Command Guide or the 
Cisco ONS 15454 SDH TL1 Command Guide.

Caution To complete this procedure, a span will be disconnected where the new node is added. This will affect 
the service of any unprotected circuits that pass through that span.

Step 1 At the node that will be added, complete the “NTP-G51 Verify DWDM Node Turn Up” procedure on 
page 6-2. If the node has not been turned up, do not continue. Complete the relevant procedures in 
Chapter 3, “Turn Up a Node” and Chapter 4, “Perform Node Acceptance Tests,” then begin this 
procedure again.

Step 2 If the Cisco MetroPlanner network design has not been updated and recalculated for the new node and 
client services, update and recalculate it now, following the procedures in the Cisco MetroPlanner 
documentation.

Step 3 Identify the fiber spans that must be disconnected to insert the new node.

Step 4 Complete the “DLP-G46 Log into CTC” task on page 2-27 at a DWDM node that is active on the 
network where you want to add the new DWDM node.

Step 5 In network view, click the Circuits tab. 

Step 6 Identify the OCHCCs and/or OCHNCs that are carried on the fiber span express path that you identified 
in Step 3 in both the east-to-west and west-to-east directions. 

Purpose This procedure adds a DWDM node to an existing Multi-Service Transport 
Platform (MSTP) network.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

A Cisco MetroPlanner network plan recalculated for the new node

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 If the OCHCC and/or OCHNC circuit is on the active path and is protected by a splitter or Y-cable 
protection group, complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task 
on page 10-39 to force traffic away from the span where the node will be added. If not, continue with 
Step 8.

Step 8 For each circuit identified in Step 6 that was not switched in Step 7 (unprotected circuits), complete the 
following steps:

a. In network view, select the OCHNC and/or OCHCC circuit and click Edit. 

b. In the Edit Circuit dialog box, click the State tab. 

c. In the State field on the right, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the 
drop-down list.

d. Click Apply, then click OK.

Step 9 Remove the fibers from the cards at the adjacent nodes that will connect to the new node.

Step 10 Install the fibers from the adjacent nodes that will connect to the new node using the “NTP-G34 Install 
Fiber-Optic Cables on DWDM Cards and DCUs” procedure on page 3-57.

Step 11 Create cross-connects on the new node for all circuits identified in Step 6:

a. From the Tools menu, choose Open TL1 Connection. 

b. In the Select Node dialog box, choose the new node and click OK. 

c. In the TL1 dialog box, use the ENT-OCHNC command to create the OCHNC cross-connects for 
each unprotected pass-through circuit as follows: 

ENT-OCHNC:[<TID>]:<SRC>,<DST>:<CTAG>::[<WCT>]:[CKTID=<CKTID>],
[CMDMDE=<CMDMDE>]:[<PST>[,<SST>]]; 

where: 

– <SRC> is the source access identifier from the CHANNEL section. In two-way wavelength 
connection sources, both directions need to be indicated. 

– <DST> is the destination access identifier from the LINE section. In two-way wavelength 
connection sources, both directions need to be indicated. 

– <WCT> is the wavelength connection type, either 1WAY or 2WAY. The default is 1WAY. 

– <CKTID> is the cross-connect ID. The default is Blank or None. CKTID is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null the CKTID field will not be 
displayed.

– <CMDMDE> is the command execution mode. 

– <PST> is the primary state, either IS or OOS. 

– <SST> is the secondary state. 

For additional information and a list of valid command values, see the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH TL1 Command Guide.

d. Click Close to close the TL1 dialog box.

e. Repeat Step 8 to change the circuits placed in OOS,DSBLD (ANSI) or Locked,disabled (ETSI) back 
in service by choosing IS-AINS (ANSI) or Unlocked,automaticInService (ETSI) in the State 
drop-down list.

Step 12 Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on 
page 10-40 for the circuits that were switched in Step 7 to return the traffic to its original paths.

Step 13 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 for circuits 
identified in Step 6 that will not be part of the traffic matrix after the node is added.
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Step 14 Complete the “DLP-G105 Provision Optical Channel Network Connections” task on page 7-10 to create 
new circuits.

Stop. You have completed this procedure.

NTP-G130 Remove a DWDM Node

Note During this procedure, you will use TL1 commands to delete and recreate OCHNC or OCHCC 
cross-connects. You might need to refer to the Cisco ONS SONET TL1 Command Guide or the 
Cisco ONS 15454 SDH TL1 Command Guide.

Caution This procedure will affect the service of unprotected circuits that pass through the span where the node 
will be removed.

Step 1 If the Cisco MetroPlanner network design has not been updated and recalculated with the node removed, 
update and recalculate the design now by following the procedures in the Cisco MetroPlanner 
documentation.

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-27 at the DWDM target node that will be 
deleted.

Step 3 Click the Circuits tab.

Step 4 Identify all the OCHNCs and OCHCCs that are passing through or are added and dropped at the node 
that will be removed.

Step 5 Delete the OCHNCs and OCHCCs identified in Step 4 that terminate (add/drop) on the target DWDM 
node. See the “DLP-G347 Delete Optical Channel Client Connections” task on page 7-8 and the 
“DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 to delete OCHCCs and 
OCHNCs, respectively.

Step 6 For the protected pass through circuits on the target node, perform Step 7. Else, go to Step 10.

Note Non-protected pass through circuits need not be modified or deleted.

Step 7 If the OCHNC and OCHCC circuits pass through the target node on the active path and are protected by 
a splitter or Y-cable protection group, navigate to an adjacent node connected to the target node and 
complete the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-39 to 
force the traffic away from the node that will be deleted. Otherwise, continue with Step 8.

Purpose This procedure removes a node from a DWDM network.

Tools/Equipment None

Prerequisite Procedures A Cisco MetroPlanner network plan recalculated for the new topology.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 8 Complete the following steps for the protected pass through circuits:

a. Select the OCHNCs or OCHCCs and click Edit. 

b. In the Edit Circuit dialog box, click the State tab. 

c. In the State field, choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI) from the drop-down list.

d. Click Apply, then click OK.

Step 9 Complete the following steps to delete thecross-connects on the target node for each circuit placed in the 
OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state in Step 8:

a. From the Tools menu, choose Open TL1 Connection. 

b. In the Select Node dialog box, select the new node and click OK. 

c. In the TL1 dialog box, use the DLT-OCHNC command to delete the OCHNC cross-connects for 
each unprotected pass-through circuit as follows: 

DLT-OCHNC:[<TID>]:<SRC>,<DST>:<CTAG>:::[CKTID=<CKTID>], 
[CMDMDE=<CMDMDE>]; 

where: 

– <SRC> is the source access identifier from the Channel section in a two-way wavelength.

– <DST> is the destination access identifier from the LINEWL section in a two-way wavelength.

– <CKTID> is the cross-connect ID. The default is Blank or None. CKTD is a string of ASCII 
characters. The maximum length is 48. If CKTID is empty or null, the CKTID field will not be 
displayed.

– <CMDMDE> is the command execution mode. NORM mode is the default behavior for all 
commands but you can specify FRCD to force the system to override a state in which the 
command would normally be denied. 

For additional information, including valid command values, refer to the Cisco ONS SONET TL1 
Command Guide or the Cisco ONS 15454 SDH and Cisco ONS 15600 SDH TL1 Command Guide.

d. Click Close to close the TL1 dialog box.

Step 10 Remove the fibers from the target node, and reconnect the fibers to the adjacent nodes.
Note that once the fibers are rerouted, the non-protected pass through circuits will go to 
OOS-PARTIAL (ANSI) or Locked-partial (ETSI) state.

Step 11 Complete the following steps to update the ANS parameters at the adjacent nodes:

a. Display an adjacent node in node view.

b. Complete the “NTP-G143 Import the Cisco MetroPlanner NE Update Configuration File” procedure 
on page 3-39 to load the new NE Update file onto the node.

c. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-83 to recalculate the 
ANS parameters at the node.

d. Display the next adjacent node in node view.

e. Repeat Steps b and c for the second adjacent node.

Step 12 Repeat Step 8 to change the circuits placed in OOS,DSBLD (ANSI) or Locked,disabled (ETSI) back in 
service by changing the Target Circuit Admin State field to IS-AINS (ANSI) or 
Unlocked,AutomaticInService (ETSI).

Step 13 Complete the “DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on 
page 10-40 for the OCHNCs and OCHCCs that were switched in Step 7.
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Step 14 To discover the non-protected pass though circuits that are in the OOS-PARTIAL (ANSI) or 
Locked-partial (ETSI) state after completing Step 10, select the circuit and choose Tools > Circuits > 
Reconfigure Circuits from the menu bar. The Reconfigure Circuits dialog box is displayed; click Yes.

Stop. You have completed this procedure.

NTP-G146 Add a Rack and/or Shelf to a Multishelf Node

Note Each shelf you want to add to a multishelf configuration must have network connectivity. For more 
information, see Chapter 2, “Connect the PC and Log into the GUI.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-27 at the multishelf DWDM node where you 
want to add a shelf.

Step 2 To add a rack, in multishelf view right-click the gray area and choose Add Rack. If you do not need to 
add a rack, continue with Step 3.

Step 3 To add a shelf, in multishelf view, right-click the white space inside the rack and choose Add Shelf.

Step 4 In the Shelf ID Selection dialog box, choose a shelf ID from the drop-down list. 

Step 5 Click OK. The shelf appears in the multishelf view.

Step 6 Complete the “DLP-G46 Log into CTC” task on page 2-27 at the subtending shelf.

Step 7 In multishelf view, click the Provisioning > General > Multishelf Config tabs.

Step 8 Click Enable as Subtended Shelf. 

Step 9 From the Shelf ID drop-down list, choose the shelf ID that you created in Step 4.

Step 10 Click Apply. 

Step 11 In the confirmation dialog box, click Yes to reboot the shelf. The CTC view changes to network view 
and the node icon changes to gray. (This might take several minutes.) 

Purpose This procedure adds a rack and/or subtending shelf to a multishelf node.

Tools/Equipment None

Prerequisite Procedures One of the following:

• NTP-G145 Connect a Multishelf Node and Subtending Shelves to an 
MS-ISC-100T Card, page 1-81

• NTP-G158 Connect a Multishelf Node and Subtending Shelves to a 
Catalyst 2950, page 1-83

Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 12 If you are connecting the new subtending shelf to the Ethernet Adapter Panel (EAP), complete the 
following steps. If not, continue with Step 13.

a. Using a cross-over (CAT 5) LAN cable, plug one connector into the RJ-45 front panel port of the 
subtending shelf TCC2/TCC2P card in Slot 7 and plug the other end into the SSC port on the left 
patch panel. 

b. Using a cross-over (CAT 5) LAN cable, plug one connector into the RJ-45 front panel port of the 
subtending shelf TCC2/TCC2P card in Slot 11 and plug the other end into the SSC port on the right 
patch panel.

Step 13 If you are connecting the subtending shelf to the Catalyst 2950 switch, complete the following steps. If 
not, continue with Step 14.

a. Plug one end of a cross-over (CAT-5) LAN cable into the RJ-45 front panel port of the subtending 
shelf TCC2/TCC2P card in Slot 7 and plug the other end into Port 2 of the first Catalyst 2950.

b. Plug one end of a cross-over (CAT-5) LAN cable into the RJ-45 front panel port of the subtending 
shelf TCC2/TCC2P card in Slot 11 and plug the other end into Port 2 of the backup Catalyst 2950.

Step 14 Repeat Steps 3 through 12 for each subtending shelf in the multishelf configuration.

Stop. You have completed this procedure.

NTP-G147 Delete a Shelf and/or Rack from a Multishelf Node

Note You cannot delete a node controller shelf from a multishelf node configuration.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-27 at the multishelf DWDM node where you 
want to delete a shelf or rack. If you want to delete a shelf, continue with Step 2. If you want to delete a 
rack only, go to Step 9.

Step 2 Complete the following tasks, as needed: 

• If cards on the shelf carry unprotected circuits, you must delete the circuits. Complete the 
“DLP-G106 Delete Optical Channel Network Connections” task on page 7-12 and/or the 
“DLP-G347 Delete Optical Channel Client Connections” task on page 7-8.

Purpose This procedure deletes a shelf and/or rack from a multishelf node in the 
CTC window.

Tools/Equipment None

Prerequisite Procedures One of the following:

• NTP-G145 Connect a Multishelf Node and Subtending Shelves to an 
MS-ISC-100T Card, page 1-81

• NTP-G158 Connect a Multishelf Node and Subtending Shelves to a 
Catalyst 2950, page 1-83

Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• If cards use internal patchcords, complete the “DLP-G355 Delete an Internal Patchcord” task on 
page 3-83.

• If OSCM or OSC-CSM cards with OSC or GCC terminations are on the shelf, complete the 
“NTP-G85 Modify or Delete OSC Terminations, DCC/GCC Terminations, and Provisionable 
Patchcords” procedure on page 10-43 to delete the terminations.

• Put all ports in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) (ANSI) or 
Locked-enabled,disabled (ETSI) service state. For more information, see Chapter 11, “Change 
DWDM Card Settings.”

Note It is not necessary to delete the cards from the shelf before deleting a shelf.

Step 3 From the View menu, choose Go to Parent View to return to multishelf view.

Step 4 Right-click on the subtending shelf you want to delete and choose Delete Shelf.

Step 5 In the confirmation dialog box, click Yes.

Step 6 To return the deleted shelf to a single-shelf node, you must use the LCD panel: 

a. Repeatedly press the Status button until Shelf Status appears. 

b. Repeatedly press the Port button until Controller Status=MS Config appears. 

c. Press Status again and press Port to set multishelf mode to MS=N. 

d. Press Status to choose Done. 

e. Repeatedly press Status until “Save and Reboot?” appears, and then press Slot to choose Apply. 
This reboots the shelf. A “Saving changes; TCC may reboot” message appears on the LCD.

Step 7 After the TCC2/TCC2P reboot is complete, complete the following steps to disconnect the removed 
subtending shelf from the patch panel or Catalyst 2950:

a. Remove the cross-over (CAT 5) LAN cable from the RJ-45 front panel port of the TCC2/TCC2P 
card in Slot 7. 

b. Remove the cross-over (CAT 5) LAN cable from the RJ-45 front panel port of the TCC2/TCC2P 
card in Slot 11.

Step 8 Reconnect the shelf to the LAN through either the backplane or one of the RJ-45 front panel ports of the 
TCC2/TCC2P cards. For more information, see Chapter 2, “Connect the PC and Log into the GUI.”

Step 9 To delete an empty rack from the CTC window, right-click in the gray area on the rack graphic and 
choose Delete Rack. 

Stop. You have completed this procedure.
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